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1. Vigtigt

Denne elektroniske brugervejledning er beregnet
til alle, der bruger Philips-skaermen. Tag den tid du
behgver for at laese vejledningen, inden du bruger

skaeermen. Den indeholder vigtige oplysninger om
bemarkninger angaende brugen af din skeerm.

Philips garanti deekker under forudseetning af, at
produktet behandles korrekt og anvendes til det
tilsigtede formadl i overensstemmelse med dens
betjeningsvejledning, og ved forevisning af den
originale faktura eller kvittering med angivelse af
kgbsdatoen, forhandlerens navn samt model og
produktionsnummer for produktet.

1.1 Sikkerhedsforanstaltninger og vedligeholdelse

() Advarsler

Anvendelse af kontrolelementer, justeringer eller
fremgangsmader, der ikke er beskrevet i denne
dokumentation, kan resultere i elektrisk stad,
elektriske ulykker og/eller mekaniske ulykker:
Laes og falg disse vejledninger, nar du tilslutter og
anvender din computerskaerm:

Betjening:

*  Hold skeermen veek fra direkte sollys og veek
fra brendeovne og andre varmekilder:

* Fjern alt, der kan risikere at falde i
ventilationshullerne eller forhindre korrekt
afkeling af skeermens elektronik.

* Bloker ikke ventilationshullerne pa kabinettet.

* Ved placering af skaermen skal du sikre dig,
at det er let at komme til stremstikket og
stikkontakten.

*  Hvis der slukkes for skeermen ved at fierne

stremkablet eller jeevnstremsledningen, skal du

vente 6 sekunder; for du satter stremkablet
eller jevnstremsledningen til igen for at opna
normal betjening.

Brug altid et godkendt stremkabel, der

er leveret af Philips. Hvis du mangler dit
strgmkabel, skal du kontakte dit lokale
servicecenter. (Se Informationscenter for
kundepleje)

Udseet ikke skeermen for kraftige vibrationer
eller stad under anvendelse.

SId ikke pa skeermen, og tab den ikke under
brug eller transport.

Vedligeholdelse:

Som en beskyttelse af skeermen skal du undga
at trykke kraftigt pa skeermpanelet. Nar du
flytter din skaerm, sa tag fat om rammen for at
lzfte den; laft ikke skeermen ved at satte din
hand eller fingre pa skeermpanelet.
Tag stikket ud fra skeermen, hvis du ikke skal
bruge den i en leengere periode.
Tag stikket ud at kontakten til skeermen, hvis
du skal renggre den med en let fugtet klud.
Skaermen kan tgrres af med en tar klud,
nar der er slukket for stremmen. Under alle
omsteendigheder, ma der ikke bruges organiske
oplgsningsmidler til rengaring af din skeerm.
For at undga risiko for elektrisk sted eller
permant beskadigelse af anleegget, sa ma du
ikke udseette skeermen for stev, regn, vand eller
miljiger med hgj fugtighed.
Huvis din skaem bliver vad, skal den terres af
med en ter klud sa hurtigt som muligt.
Hvis der kommer fremmed substans eller vand
ind i skeermen, sa sluk straks for stremmen og
tag stikker ud. Fjern derefter den fremmede
substans eller vandet, og send skaermen til
servicecenteret.
Skeermen ma ikke bruges eller opbevares pa
steder; hvor den udsettes for varme, direkte
sollys eller ekstrem kulde.
For at opretholde den bedste ydelse af din
skeerm og for langvarig brug, sa brug skeermen
et sted, der er indenfor felgende temperatur-
og fugtighedsomrade.

o Temperatur: 0-40°C 32-95°F

o Fugtighed: 20-80% RH



*  VIGTIGT: Segrg altid for at aktivere en
pauseskeerm, der bevaeger sig, nar skermen
efterlades uden at blive anvendt. Du skal altid
bruge en pauseskarm eller et andet program,
der opdaterer skaermen regelmaessigt, hvis
du viser statisk materiale i lengere perioder.
Uafbrudt visning af stille eller statiske billeder
over en lengere periode kan fordrsage, at det
“breendes fast” pa skeermen, dvs. de sakaldte
“spogelsesbilleder” pa din skaerm.

* Fastbreending” og "spagelsesbilleder”
er velkendte faenomener inden for
skeermpanel-teknologien. “Fastbreending” og
“'spagelsesbilleder” forsvinder oftest gradvist
efter en vis periode, efter skaermen er slukket.

) Advarsel

Imidlertid forsvinder alvorligere tilfeelde af
“fastbreending” og “‘spagelsesbilleder” ikke og kan
ej heller fiernes ved reparation. Ovennzvnte
skader er ikke daekket af garantien.

Service
* Kabinettet ma kun &bnes af kvalificeret
servicepersonale.

* Hovis der er behov for et dokument til
reparation eller integration, sa kontakt
dit lokale servicecenter. (Se kapitel om
"Kundeinformationscenter")

»  For oplysninger om transport, se "Tekniske
specifikationer”.

» Efterlad ikke din skeerm i en bil/lbagagerum
under direkte sollys.

& Bemzrkning

Kontakt en servicetekniker, hvis skaermen ikke
fungerer korrekt, eller hvis du er usikker pd, hvad
du skal gere, ndr betjeningsinstruktionerne, der er
givet i denne manual, er fulgt.

1.2 Notationsbeskrivelser

Felgende underafsnit beskriver de
notationsmaessige konventioner, der benyttes i
dette dokument.

Bemaerkninger, forsigtighedsregler og advarsler

| hele denne vejledning kan tekstblokke veere
ledsaget af et ikon og std med fed eller kursiv
skrift. Disse blokke indeholder bemazerkninger og
punkter, hvor der skal udvises forsigtighed, eller
advarsler. De anvendes som falger:

© Bemarkning

Dette ikon angiver vigtige oplysninger og
tips, hvormed du kan gere bedre brug af
computersystemet.

© Forsigtig

Dette ikon angiver oplysninger om, hvordan du
undgar risiko for skader pa hardwaren eller tab af
data.

D Advarsel

Dette ikon angiver risiko for personskader og
hvordan dette undgds.

Visse advarsler kan optrede i andre formater og
er eventuelt ikke ledsaget af et ikon. | sadanne
tilfeelde er den givne udformning af advarslen
lovmaessigt obligatorisk.



1.3 Bortskaffelse af produkt og emballage

Waste Electrical and Electronic Equipment-
WEEE

This marking on the product or on its packaging
illustrates that, under European Directive 2002/96/
EC governing used electrical and electronic
appliances, this product may not be disposed

of with normal household waste.You are
responsible for disposal of this equipment through
a designated waste electrical and electronic
equipment collection. To determine the locations
for dropping off such waste electrical and
electronic, contact your local government office,
the waste disposal organization that serves your
household or the store at which you purchased
the product.

Your new monitor contains materials that can be
recycled and reused. Specialized companies can
recycle your product to increase the amount of
reusable materials and to minimize the amount to
be disposed of.

All redundant packing material has been omitted.
We have done our utmost to make the packaging
easily separable into mono materials.

Please find out about the local regulations on how
to dispose of your old monitor and packing from
your sales representative.

Recycling Information for Customers

Your display is manufactured with high quality
materials and components which can be recycled
and reused.

To learn more about our recycling program please

visit wwwi.philips.com/about/sustainability/recycling.



2. Opsatning af skerm

2.1 Installation

El Emballagens indhold

m

Quick

Start

PHILIPS

!

5y <
~

VGA signal cable (optional)

S

DVI cable (optional)

E Installation af stander

1.

Anbring skaermen pa en javn, bled overflade
med forsiden vendt nedad og var forsigtig
med at undga at ridse eller beskadige
skeermen. Left derefter skeermens stander.

2. Hold pa skeermens stander med begge
heaender og st med en fast hand standeren
ind i fodsgjlen.




E Tilslutning til PC

PHILIPS

Kensington anti-tyverisikring
AC stremindgang

DVI-D input

(tilgeengelig i udvalgte modeller)
VGA-indgang

Tilslutning til pc

1.

Tilslut elledningen ordentligt pa bagsiden
af skarmen.

Sluk for computeren og tag netledningen
ud af stikket.

Slut skeermens signalkabel til videostikket
bag pd computeren.

Seet computerens og skaermens
netledninger til et stik i neerheden.

Teend for computeren og skarmen. Hvis
skeermen viser et billede, er installationen
fuldfert.

2.2 Brug af skaerm

El Produktbeskrivelse set forfra
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Sadan far du adgang til OSD-menuen.
Ga tilbage til det forrige OSD-niveau.
Skift til 4:3 billedformat.

: Sadan tendes og slukkes for skeermen.
: Til indstilling af OSD menui.

Til ndring af signalindgangskilde.
Smartlmage Lite. Der kan veelges
mellem 3 tilstande: Standard
(Standard), Intemet (Intemet),
Game (Spil).



E1 Beskrivelse af OSD-displayet OSD-menuen

Nedenstadende er en generel oversigt over
strukturen i OSD-displayet. Du kan anvende den
som opslag, nar du senere skal orientere dig i de
Visning pa skeermen [On-Screen Display (OSD)] forskellige justeringer.

Hvad er OSD (On-Screen Display)?

er en funktion pa alle Philips skeerme. Den setter
en slutbruger i stand til at justere skaermindstilling
eller valge skaerm ens funktioner direkte via [ e
et instruktionsvindue direkte pa skaermen. Et

brugervenligt skaermvisningsinterface vises som

Main menu Sub menu

VGA
[ DVI (available for selective models)

Picture Format — Wide screen, 4:3
nedenfor: L Picture
Brightness — 0~100
Contrast — 0~100
SmartContrast — ©On, Off
Color Temp. — 6500K, 9300K
+— Color
sRGB

User Define Red: 0~100
E Green: 0~100
Blue: 0~100

I— Language English . Espafiol, Frangais, Deutsch, Italiano,

Portugués, Pycckuii, /1

— Horizontal — 0~100
{— OSD Settings
Lo X Vertical — 0~100
Grundleggende og enkle anvisninger til Transgareny — O 1,2,3,4

kontrolknapperne OSD Time out — 55.105,205,30s, 60's

Auto

P3 OSD-skaermen, der er vist ovenfor, kan brugere

trykke pa w A-knapperne pd skarmens frontkant L sewp [ H. Position — 0100
for at bevaege cursoren, OK for at bekreefte valget | V-Position — 0100
eller for at e&ndre. — Phase — 0-100
[ Clock — 0~100

Resolution Notification — On, Off

Reset — Yes, No

Information



El Meddelelse om oplasning

Denne skaerm er designet til optimal ydelse

ved dens naturlige oplasning: 1440x900@60Hz.

Nar skeermen keres pa en anden oplasning,
ses folgende advarsel pa skeermen: De bedste
resultater opnds med 1440x900@60Hz.
Advarslen vedrgrende den naturlige oplasning
kan deaktiveres under Installation i OSD
(skeermmenuen).

3 Fysisk funktion

Vip

2.3 Fjern standeren og foden

El Fjern standeren

Inden du begynder at adskille skeermens stander;
skal du felge vejledningerne nedenfor for at undga
beskadigelse og personskade.

1. Anbring skeermen med forsiden vendt nedad
pa en jeevn overflade, og vaer forsigtig med ikke
at ridse eller beskadige skarmen.

2. Tryk pd laseklipsene for at fierne basisstatten
fra basiskolonnen.




El Fjernelse af foden © Bemarkning

Denne skarm accepterer et 100mm x 100mm

Betingelse: VESA-kompliant monteringsinterface.

* For standard montering af VESA

s A

1. Fern de 4 skruer pa kabinettet. PHILIPS
OO AN
-— O 100mm O
100mm
© ®
| ’
— A

2. Fjern de 4 skruer og fiern derefter foden fra
skeermen.




3. Optimering af billede

3.1 Smartlmage Lite

El Hvad er dette?

Smartimage Lite er forvalgte indstillinger; der
optimerer skeermen i henhold til indholdet, og
som realtid dynamisk indstiller lysstyrke, kontrast,
farve og skarphed. Uanset om du arbejder med
tekstprogrammer, ser billeder eller ser video,

sa giver Philips Smartlmage Lite den optimale
skeermydelse.

El Hvorfor behgver jeg det?

Du gnsker en skaerm, som giver det bedste
billede for alle typer indhold. For at @ge skaerm-
oplevelsen, indstiller Smartimage Lite-softwaret
dynamisk lysstyrke, kontrast, farve og skarphed i
realtid.

El Hvordan virker det?

Smartlmage Lite er en eksklusiv, ferende Philips-
teknologi, som analyserer indholdet pa skarmen.
Ud fra det valgte scenarie forbedrer Smartlmage
Lite dynamisk billeders og videoers kontrast,
farvemeethed og skarphed for at forbedre det
viste billede - alt i realtid og blot med et tryk pa
en knap.

Bl Hvordan aktiveres Smartlmage Lite?

1. Tryk p& B for at starte Smartimage Lite pd
skaermen;

2. Fortset med at trykke pd B for at skifte
mellem Standard (Standard), Internet
(Internet), Game (Spil).

3. Smartlmage Lite ses pa skeermen i fem
sekunder, men du kan ogsa trykke pa OK for
at bekreefte.

4. Nar Smartlmage Lite er aktiveret, deaktiveres
sRGB systemet automatisk. For at bruge sRGB
skal du deaktivere Smartlmage Lite med E
foran pa skeermen.

Udover at bruge B til at rulle ned med, kan du
ogsa trykke pa w a for at vaelge og derefter trykke
pa OK for at bekreefte valget og derefter igen
lukke Smartimage Lite OSD.



Der kan veelges mellem 3 tilstande: Standard, 3.2 SmartContrast

Internet, Game (Spil).

@ uS_;nanImaga

Standard

Internet

Standard: Forbedrer teksten og deemper
lysstyrken for at gge leesbarheden og nedsztte
anstrengelsen af gjnene. Denne tilstand @ger
afgerende leesbarheden og produktiviteten, nar
der arbejdes med regneark, PDF filer, skannede
artikler og andre generelle kontorprogrammer.
Internet: Denne profil kombinerer
farvemathed og dynamisk kontrast og
skarphed for at vise billeder og lignende
overordentlig klart og i levende farver - alt
uden synlige fejl i det indskannede billede og
blegnede farver.

Game (Spil): Aktivér overdrive-kredslgbet for
at fd den bedste reaktionstid, reducere skaeve
kanter for genstande, der beveaeger sig hurtigt
pa skaermen, forbedre kontrastforholdet for

lys og marke. Denne profil giver spillere den
bedste oplevelse af spil.

10

El Hvad er dette?

Unik teknologi, der dynamisk analyserer det viste
indhold og automatisk optimerer en skarms
kontrastforhold til maksimal visuel klarhed.

Den gger baggrundsbelysningen og giver et
klarere, friskere og lysere billede eller deemper
baggrundsbelysningen med henblik pa en tydelig
visning af billeder pa merk baggrund.

E1 Hvorfor behgver jeg det?

Du gnsker den allerbedste visuelle klarhed

og visning ved enhver type indhold. Smart-
kontrast styrer dynamisk kontrast og indstiller
baggrundslyset, sa det giver klare, friske og lyse
spil- og videobilleder og viser tydelig, leesbar tekst
ved kontorarbejde.Ved at nedsette skaeermens
stremforbrug, sparer du energiomkostninger og
forlenger skaermens levetid.

El Hvordan virker det?

Nar du aktiverer SmartContrast, analyseres

det viste indhold i realtid for at indstille farver

og baggrundslysets intensitet. Denne funktion
forbedrer dynamisk kontrasten og giver saledes en
bedre underholdningsoplevelse, nar du ser videoer
eller spiller spil.



3.3 Philips SmartControl Lite Guide for forste start
* Efter installation af SmartControl Lite abnes

Det nye SmartControl Lite-software fra Phillips guiden automatisk, nar du bner programmet
giver dig mulighed for at kontrollere skeermen via forste gang.

et nemt, grafisk interface. Komplicerede justeringer «  Guiden leder dig trin for trin gennem indstilling
harer fortiden til. Dette brugervenlige software af skaermen.

guider dig gennem finindstilling af oplasning, +  Du kan ogsa g4 til Plug-in menuen for at starte
kalibrering af farve, justeringer af clockning/fase, suiden pa et senere tidspunkt.

RGB-hvidpunkt osv. + | Standard-ruden kan du indstille flere

funktioner uden guide.
Udstyret med den seneste teknologi i algoritmer

for hurtig behandling og reaktion, er denne

igjnefaldende, ikon-baserede software, der ogsa er
Windows 7 parat, klar til at forbedre din oplevelse S
med Philips-skaerme! acris . e e

8 SmartControl 2. Philps 22581 (CS30715000001) ()X

SmartControl Lite PHILIPS

 disply to get the most
o he

1. Choose the Start
2. Folow the steps outined i t
3. Save your settings for fut

]

El Installation P 2
* Folg instruktionen og fuldfer installationen.
¢ Du kan starte, nar installationen er fuldfert.
*  Hvis du vil begynde senere, kan du klikke g
pa genvejen pa skrivebordet eller pa 25 =
vaerktgjslinjen.

i0

input

g

Multi Monitors

&

Help

PHILIPS www philips.com/welcome St W

Recuird seps Monitor driver and software installation

i loae Sysem reqiremenss

P running Windovws 7. Vi, XP, 2000, 98

Philps SmareControl
Syom swpport snd requrement:
1. Sytam support Windows 7. Vs X.

s, French,olan, Russan, P ihed Chnsse
3. Pilps Monior Pl and Pay scpport

sofvare

I



F1 Start med Standard-rude:

Adjust menu (Indstillingsmenu):
*  Med "Adjust" ("Indstilling"-)menuen kan du
indstille Brightness (Lysstyrke), Contrast

(Kontrast), Focus (Fokus), Position (Position)

og Resolution (Oplgsning).

* Foretag indstillingen ved at folge
instruktionerne.

* Installationen kan annulleres med Cancel
(Annuller).

8 smartcontrol 2- Phiips 22581 (CS30715000001)

SmartControl Lite

Brightness

2x

PHILIPS

Improperly adjusted Brightness wil result 1 a loss of
detai n darker image areas. Adust the Brightness for

the best possble picture qualty.

1. Lower the Brightness to the minimum level
2. Rasse the Brightness to the desired level.
3. Adjust the Brightness as needed to achieve
an equal separaton of the strpes.
Adjust
Brghtness
X' Contrast
" Foaus ness 00
— srights 1
o o
Postion
undo Reset
g Resolution
B SmartControl 2 - Philps 22581 (C530715000001) {2,

SmartControl Lite

Contrast

PHILIPS

Adjust the Contrast (use the sider) to keep detais in

lghter image areas.

are o longer vsble.
. Slowly lower the Contrast to make the

should remain barely visb
b)

Brightness

Contrast

28

A Foaus Contrast

¥ © .

numbers 2 and 3 reappear. The number 1

. Rae the Contrast unti the numbers 1 and 2

&y

Options Undo Reset

g Resolution

==

@ smantconwol

SmartControl Lite

Adjust Q
‘ Brightness
Contrast
Color
b Postion
Options.
Resoluton

Help

8 smartcontrol

SmartControl Lite

p)

Brightness
Contrast

Focus

g Resoluton
Help

8 smartcontrol

SmartControl Lite

Adjust 0

Brightness

Contrast

Color 28

- Focus

Postion

ition

2. phips 22581 (csa0715000001) (T
PHILIPS

Focus
Y it i e
the video s
1. Choose Auto Setup.
% X themtial s s i il o need
o adust the P

Pitch: Try to make the vertical bands dsappear.
Phase: Adjust to the brightest setting to minmze
movement on the screen.

pitch 50
&
Phase 17
@

o _ AuoSetwp

2 - phips 22581 (CS30715000001) (2} %)

PHILIPS

Position

Use the Position buttons to center the image on
your display. Using this tool, you can position the image
up, down, left, or ight.

Use the Up/Down buttons to center the image

rticaly.
Use the Left/Right buttons to center the image
zontaly.

Undo Reset

2- Phips 22581 (C530715000001) (Z%)
PHILIPS

Resolution

You are currently 3t 3 Preferred resolution. For your
dplay to show crsp, dlear text, colors, and images
Your disply should be set to fs Preferred resolution.
I your display & at a Non-Preferred resolution, clck
on the Preferred button to change your resoltion to

™ Enable Resolution Notfier

Picture Format
I 43 asect ratio




Farvemenu:
Med "Color" ("Farve"-)menuen kan du
indstille RGB, Black Level (Sortniveau),
White Point (Hvidpunkt), Color Calibration
(Farvekalibrering) og Smart-Billede

(se afsnittet Smart-Billede).

Foretag indstillingen ved at felge

instruktionerne.

Se nedenstaende oversigt med
undermenupunkter baseret pa dit input.
Eksempel pa Color Calibration

(Farvekalibrering)

g smartcontrol

SmartControl Lite

4

Biack Level

ae

g

‘White Point

Dispy Garima
!
Galbration

@ap

Smartimage

f

®

@8 smartcontrol

SmartControl Lite

RGB.

Back Level

ae

8

‘white Pont.

Display Gamma
!
Galbration

@—7

Smartimage

l

g
2

8

2- Phips 22581 (€530715000001) {2 (%)
PHILIPS

RGB

Al dspiayed colors are produced by maing Red, Blue,
and Green at different brightness levek. Choosng a
neutral White Pont wil give you optimal RG. If you
prefer to adjust the RGB now, folow thess steps:

1. Adjust the intensty of the Red, Green, and

8lue using the sider bars.

NOTE: Changing the RGB values can adversely effect
the displayed colors.

Red 100

= oW

Green 100

g Ow

Ble 100

= CWw
Undo Reset

2- phips 22581 (cs30715000001) {Z)%)

PHILIPS

White Point

‘White Point s the pont at which equal combriations
of red, green, and blue ight at ful intensty create
white. Thi effects the overal color quaity. For the
most accurate colors cick the Reset button then
select the Whe Point.
1. Please select the White Pont value for the best
possible color quaity.

White Porit as00k
o C© &7
Undo. Reset

13

8 smartcontol

SmartControl Lite

Adiust RGE
Color Wite Point
Display Gamma
J
Opbons Calbration
@ap
srariage

®

8 smantcontol

SmartControl Lite

"

Disply Gamma

! I
Calbration

@p

Smartimage

L

2- Philps 22581 (CS30715000001) (2)X)
PHILIPS

Display Gamma

Gamrma is 2 component of the pixel brightness in 2
display. A lower Garma vakue produces brighter pixels
and a higher Gamma value produces darker pixes. The
defauk value for Gamma & 2.2.

To adjust Gamma, Smartimage must be set to Off.
Clck the Smartlmage Off button before adjusting
ma.

1. Use the sider to select the desred Gamm.

Display Gamma 22
o © &
Smartimage OFF
undo Reset

2 Phips 22581 (cS30715000001) (2%

PHILIPS

Calibration

Your dispiay needs to be properly calibrated i order
for  to produce the widest range of colrs accurately.
Calibration should ahays take place as the kst tuning
step in the process. Remember to recalbrate any time
you make indiidual adjustments to image qualey or
whenever you move your dsplay to a new location.
Make 3l other necessary adjustments to image
qualey frst.
Press Show Me to learm how to use the
calibration tooks.
. Finaly, press Start to begh the calibration
process.

¥ Enable color calbration
Color software desgned i colaboration with Joseph

Holmes.
Protected by U.S. Patent No. 6,686,953

Show Me start

Quick View,

"Show Me" ("Vis Mig") starter vejledningen i

farvekalibrering.

"Start" - starter 6-trins farvekalibrerings-

sekvensen.

"Quick View" ("Quick-visning") indleser fer/

efter-billederne.

For at vende tilbage til "Color" ("Farve"-)

2

startruden, skal du klikke pa "Cancel"

("Annuller").

Aktiver farvekalibrering - der som standard
er aktiveret. Hvis markeringen er fiernet, kan
der ikke ske farvekalibrering, ligesom start- og
quick-visning knapperne er gratonede.

Der skal veere patent-oplysninger pa

kalibreringsskaermen.



Forst farvekalibreringsskaerm: "Options > Preferences" ("Funktioner >
Indstillinger") - er kun aktiv, nar Preferences
(Indstillinger) er valgt i "Options" ("Funktioner"-)
rullemenuen-rullemenuen. Pa en ikke-understattet
skeerm med DDC/Ci er kun "Help" ("Hjzlp") og

"Options" ("Funktioner") til radighed.

* "Previous" ("Foregdende"-) knap er deaktiveret,
indtil den anden farveskaerm.

* "Next" ("Naste") gar til efterfolgende mal (seks
mal).

*  "Final next" ("Afsluttende Naeste) gar til File >
Presets (File > Forvalg) rude.

*  "Cancel" ("Annuller") lukker Ul og vender
tilbage til "plug in"-) siden.

Smartlmage Lite

Smart-Billede - tillader brugeren at ndre
indstillingen for at opnd en bedre skaermindstilling
baseret pd indhold.

Nar der indstilles pa "Entertainment"
("Underholdning"), aktiveres Smart-Kontrast og
Smart-Svar.

I y
8 smartcontrol &

SmartControl Lite PHILIPS

SmartImage
‘Smartimage provides diferent brightness and

contrast levels to accomodate today's wide range of
computer appications.

g Chooss the setting that is most comfortable or
efficient when viewing your application. Aemativel,
m ‘smply choose the one that best descrbes s type.

Adiust RGB.
W
Back Level

White Pont

‘Color
Disly Garma
wl
cabraton

]

‘Smartimage
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8 SmartControl 2- Philps 22581 (CS30715000001) \2)(X)
SmartControl Lite PHILIPS

Preferences
You can use the olowng aptans to cofiure
SmartControl.
¥ Enable menu when right-cicking on desktop

- ¥ Enable task tray menu

Preferences ¥ Run at system start-up
et Transparency:
@ 0% C 50% € 100%
COREE Audo Select bnguage:

Englsh &

Auto Pot.

Tnput

Wizard

Presets

Muli Monitors

Viser nuveerende, foretrukne indstillinger.
Funktionen aktiveres ved at afmaerke feltet.
Afmaerkningsfeltet er en flip-flop.

"Enable Task Tray" ("Aktiver Jobbakke")
menuen er som standard afmaerket (Til)

pa skrivebordet. Menuen Enable Context
(Aktivér kontekst) viser valgmulighederne i
SmartControl Lite for Select Preset (Velg
Forvalg) og Tune Display (Indstil Display) i
genvejmenuen ved hgjreklik pa skrivebordet.
Disabled (Deaktiveret) fierner SmartControl
Lite fra kontekst-genvejsmenuen.

"Enable Context" ("Aktiver Indhold"-)
menuen er som standard afmeerket (Til)

pa skrivebordet. Menuen Enable Context
(Aktiver Indhold) ger, at systembakkens ikon
for SmartControl Lite vises. Et hgjreklik pa
jobbakke-ikonen viser menufunktionerne
for "Help" ("Hjalp") og "Technical Support"
("Teknisk Statte"). Afmaerk for "Upgrade”
("Opgradering"), "About" ("Om") og "Exit"
("Afslut"). Ndr "Enable Task Tray" ("Aktiver
Jobbakke") menuen er deaktiveret, viser
jobbakke-ikonen kun EXIT (AFSLUT).



* "Run at Startup" ("Ker ved Startop") er
som standard afmarket (Til). Nar den er
deaktiveret, starter SmartControl Lite ikke ved
starten og ikonet vises ikke i systembakken.
SmartControl Lite kan kun startes fra
genvejen pa skrivebordet eller fra programfilen.
Intet forvalg, indstillet til at kere ved startop,
indlaeses, nar denne boks ikke er afmaerket (er
deaktiveret).

*  Aktivér gennemsigtighedstilstand (Windows 7,
Vista, XP). Standard er 0% uigennemsigtighed.

"Options > Input" ("Funktioner > Indgang")

- er kun aktiv, nar "Input” ("Indgang") er valgt i
"Options" ("Funktioner"-)rullemenuen. Pa en ikke-
understgttet skeerm med DDC/Ci er kun "Help"
("Hjeelp") og "Options" ("Funktioner") til radighed.
Alle andre faneblade i SmartControl Lite er ikke til
radighed.

PHILIPS

88 SmartControl
SmartControl Lite

Input

Your dsplay has two nputs (connections on back of
this diplay) 50 you can hook up two different sources
at the same time. Use the Analog In and Digital
buttons to select which source you'd ke to

are currently viewing the analog in image.
worra
Q iose thea
vh

I you swicch inputs SmartControl may.
to control your montor. In this case you

Adjust may have to use the Input Select button on the front
! Audo of your m ch back to the orginal mput
before Sm nctonaiey can be restored.

\’ P
Color Input
) el B
\g o
2
Options Presets.
\g T
Help

Analog In Digtal In

*  Vis "Source" ("Kilde") instruktionsruden og
nuveerende indgangskilde indstilling.

*  Ved enkeltindgangsskeerme ses denne rude
ikke.

"Help > User Manual" ("Hjalp >
Brugervejledning") - er kun aktiv, nar "User Manual"
("Brugervejledning") er valgt i "Help" ("Hjeelp"-)
rullemenuen. P& en ikke-understattet skaerm med
DDC/Ci er kun "Help" ("Hjeelp") og "Options"
("Funktioner") til radighed.

2 Philps 22581 (CS30715000001) (2 X)

PHILIPS

8 SmartControl
SmartControl Lite

User Manual

1 you need help setting up or operating SmartControl,
cick the Tech. Support button. You'l have the
option to fil out an Assitance Form.

o hooee 9 hawt bfomaton sbout your
reticaly attached to the assstance
form: You'l nacd ta be onine to se the fesure.

You

]

Adjust

u;gaml

g @
D
Update
Color
e
" Diply ID
5
System 1D
Options.
&)
Verson

®

User Manual Tech. Support

"Help >Version" ("Funktioner > Version") - er
kun aktiv, nar "Version" ("Version") er valgt i "Help"
("Hjelp"-)rullemenuen. P4 en ikke-understattet
skeerm med DDC/Ci er kun "Help" ("Hjzlp") og
"Options" ("Funktioner") til radighed.

2 - Philps 22581 (C530715000001) (T

PHILIPS

8 smartcontrol
SmartControl Lite

Version

SmartControl

Version 0.00 EVALUATION dtune-pip-R2009-12-17-
1913-04

DDC/CI Communication: Yes - ATI2 APL

Copyright © 1993-2009 Portrat: Diplays, Inc.

]

Adiust
User Manual

a
®

Update

i

Color
Diplay D

System ID

Version

B8
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Context Sensitive (Indholdssensitiv) menu
"Context Sensitive" ("Indholdssensitiv") menuen
er som standard aktiveret. Hvis "Enable Context"
("Aktiver Indholdssensitiv") menuen er afmaerket
i "Options > Preferences” ("Funktioner >
Indstillinger") ruden, ses menuen.

D SmartControl
Select Preset +
Tune Dizplay

"Context" ("Indhold") menuen har fire punkter

*  SmartControl Lite - nar valgt, ses "About"
("Om") skeermen.

*  "Select Preset" ("Valg Forvalgt") - en
hierakisk menu med gemte forvalg, der
straks kan bruges. En afkrydsniong viser
det i gjeblikket valgte forvalg. "Factory
Preset" ("Fabriksforvalg") kan ogsd hentes i
rullemenuen.

* Tune Display (Indstil Skeerm) - dbner
kontrolpanelet for SmartControl Lite.

¢ Smartlmage Lite - Kontrollér aktuelle

indstillinger for Standard, Internet, Game (Spil).

"Task Tray" ("Jobbakke"-) menu aktiveret

Menuen i systembakken kan ses ved at hgjreklikke

pa SmartControl Lite-ikonet i systembakken.
Et venstreklik starter programmet.

Help

Technical Support
Check for Update
About

Exk

Jobbakken har fem punkter:

*  "Help" ("Hjeelp") - adgang til brugervejledning-

fil. Abner Brugervejledningen med standard
browservinduet.

«  "Technical Support" ("Teknisk Hjelp") - viser
siden med teknisk hjeelp.

*  "Check for Update " ("Tjek for opdateringer")
- leder brugeren til PDI Landing og tjekker
brugerens version i forhold til den allernyeste
version.

«  "About" ("Om") - viser detaljerede
referenceoplysninger: Produktversion,
frigivelses-information og produktnavn.

*  Exit (Afslut) - Luk SmartControl Lite
Hvis du vil kere To run SmartControl Lite
igen, skal du enten vaelge SmartControl
Lite i programmenuen, dobbeltklikke pa
skrivebordet eller genstarte systemet.

SmartControl

PHILIPS

SmartControl

dhune-standard-R2007-01-04-1151-23
Copyright 1983-2007 Portrait Displays, Inc.
Patets Pending

"Task Tray" ("Jobbakke"-)menu deaktiveret
Nar "Task Tray" ("Jobbakke") er deaktiveret

i indstillinger-mappen, er kun valg af "EXIT"
("AFSLUT") til radighed. Hvis du helt vil fierne
SmartControl Lite fra systembakken, skal du
deaktivere "Run at Startup" ("Ker ved Startop")
i "Options > Preferences" ("Muligheder >
Indstillinger").



4. Tekniske specifikationer

Skeermpanel-type TFT-LCD
Baggrundslys LED

Panelstarrelse 19" W (48,3 cm)
Aspektforhold 16:10

Pixel pitch 0,2835 x 0,2835 mm
Lysstyrke 250 cd/m?
Smart-kontrast 20.000.000:1
Kontrastforhold (typ.) 1000:1

Reaktionstid (normal) 5ms

Optimal oplgsning

1440 x 900 @ 60 Hz

Synsvinkel 178° (H) / 170° (V) @ C/R > 5

Billedforbedring Smartlmage Lite

Skeermfarver 16,7 M

Vertikal opdateringshastighed 56 Hz - 76 Hz

Horisontal frekvens 30 kHz - 83 kHz

sRGB JA

Signalinput DVI-D (Digital), VGA (analog)

Inputsignal Separat synk., synk. pa gren

Brugerfunktioner vy ©/a O /< /0K

OSD sprog Engelsk, fransk, tysk, italiensk, russisk, spansk, simplificeret kinesisk

og portugisisk, Tyrkisk

Andre funktioner VESA montering (100 x 100mm), kensington-las

"Plug & Play" kompatibilitet DDC/CI, sRGB, Windows 7/2000/XP/Vista, Mac OS X

Vip -5/+20
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Teendt-tilstand (typisk) 13,92W

Energiforbrug AC AC AC

(EnergyStar 5.0 testmetode) indgangsspaending indgangsspaending indgangsspaending
ved T15VAC +/- 5VAC, | 230VAC +/- 5VAC,
100VAC +/- 5VAC, | 60Hz +/- 3Hz 50Hz +/- 3Hz
50Hz +/- 3Hz

Normal funktion (typisk) 11,25W 11,16W 11,49W

Huvile (typisk) 0,5W 0,5W 0,5W

Fra 0,5W 0,5W 0,5W

Varmetab* AC AC AC
indgangsspaending indgangsspaending indgangsspaending
ved 115VAC +/- 5VAC, | 230VAC +/- 5VAC,
100VAC +/- 5VAC, | 60Hz +/- 3Hz 50Hz +/- 3Hz
50Hz +/- 3Hz

Normal drift 3840BTU 38,09BTU 39,22BTU

Sovetilstand (typisk) 1,706BTU 1,706BTU 1,706BTU

Fra 1,706BTU 1,706BTU 1,706BTU

Stremdiode Til-tilstand: Hvid, standby-/sove-tilstand: Hvid (blinker)

Stremforsyning

Produkt uden fod (BxHxD)

Indbygget, 100-240VAC, 50/60Hz

457 x 388 x 199mm

Produkt uden fod (BxHxD)

457 x 319 x 49mm

Kassemal (BxHxD)

503 x 444 x 134mm

Produkt med fod 3,6kg
Produkt uden fod 3,3kg
Produkt med emballage 4,7kg




Temperaturomrade Oplagring: -20°C til 60°C
drift: 0°C til 40°C
Relativ fugtighed 20% til 80%
Hejde Ikke drift: + 40.000 ft (12.192 m)
Betjening: + 12.000 ft (3.658 m)
MTBF 30.000 timer
[ Millsmesssige forheld
ROHS JA
EPEAT Selv (www.epeat.net)
Emballage 100% genbrugelig

Myndighedernes godkendelser | BSMI, CE Mark, FCC Class B, GOST, SEMKO, UL/cUL,

1SO9241-307
Farve Sort
Finish Skinnende

(=) Bemarkning

1. EPEAT Gold eller Silver er kun gyldig hvor produktet registreres af Philips. Ga til www.epeat.net for
registeringsstatus i dit land.

2. Disse data kan @ndres uden meddelelse derom. Ga til www.philips.com/support for at hente den
seneste version af brochuren.
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4.1 Oplesning og forvalgte indstillinger

E Maksimal oplasning

Til 196E3L
1440 x 900 ved 60 Hz (analogt input)
1440 x 900 ved 60 Hz (digital indgang)

E1 Anbefalet oplasning

Til 196E3L
1440 x 900 ved 60 Hz (digital indgang)
[V frekv (ko[ Oplosning [ Lrekv (Hz) ]
3147 720x400 70,09
28,57 640x480 66,67
37,86 640x480 72,81
37,88 800x600 60,32
48,08 800x600 72,19
56,48 1024x768 70,07
60,02 1024x768 75,03
63,85 1152x864 70,01
67,50 1152x864 75,00
52,50 1280x720 70,00
47,78 1280x768 59,87
71,69 1280x1024 6719
76,02 1280x1024 71,45
5547 1440x900 59,90
55,94 1440x900 59,89
70,64 1440x900 74,98
64,67 1680x1050 59,88
65,29 1680x1050 59,95

=] Bemarkning

Bemaerk, at skaermen fungerer bedst med den
indbyggede oplasning pa 1440 X 900 ved 60 Hz.
Folg den anbefalede oplasning for at opna den
bedste billedkvalitet.
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5. Stremstyring

5.1 Automatisk energispare

Huvis der er installeret et VESA DPM overholdende
skeermkort eller software pa pc'en, kan skermen
automatisk nedsatte strgmforbruget, nar den
ikke bruges. Nar input fra tastatur, mus eller
anden input-enhed registreres, "vagner" skaermen
automatisk igen. Nedenstdende tabel viser denne
automatiske energisparefunktions stremforbrug og

signalering:

VESA tilstand| Video |V synk| Lsynk | Forbrugt stram | Diodefarve
Aktiv TIL Ja Ja <1392W Hvid
(ypisk)
Sovetilstand | Slukket | Nej Nej | <O05W (typisk) Hvid
(blinker)
Kontakt Fra | Slukket - - <05W (typisk) | Slukket

Den folgende opsatning bruges til at male
skaermens stremforbrug.

Indbyggede oplasning: 1440 x 900
Kontrast: 50%

Lysstyrke: 250 nits
Farvetemperatur: 6500k

=] Bemarkning
Disse data kan andres uden meddelelse derom.
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6. Lovmaessige oplysninger

Lead-free Product

Lead free display promotes
environmentally sound recovery and
disposal of waste from electrical and
electronic equipment. Toxic substances
like Lead has been eliminated and compliance with
European community’s stringent RoHs directive
mandating restrictions on hazardous substances

in electrical and electronic equipment have been
adhered to in order to make Philips monitors safe
to use throughout its life cycle.

EPEAT
(www.epeat.net)
“The EPEAT (Electronic Product
% Environmental Assessment Tool)
program evaluates computer
desktops, laptops, and monitors based
on 571 environmental criteria developed through
an extensive stakeholder consensus process
supported by US EPA.
EPEAT system helps purchasers in the public
and private sectors evaluate, compare and select
desktop computers, notebooks and monitors
based on their environmental attributes. EPEAT
also provides a clear and consistent set of
performance criteria for the design of products,
and provides an opportunity for manufacturers to
secure market recognition for efforts to reduce
the environmental impact of its products.”
Benefits of EPEAT
Reduce use of primary materials
Reduce use of toxic materials
Avoid the disposal of hazardous waste EPEAT’S
requirement that all registered products meet
ENERGY STAR's energy efficiency specifications,
means that these products will consume less
energy throughout their life.
CE Declaration of Conformity

This product is in conformity with the following
standards

EN60950-1:2006 (Safety requirement of
Information Technology Equipment)
EN55022:2006 (Radio Disturbance
requirement of Information Technology
Equipment)
EN55024:1998+A1:2001+A2:2003 (Immunity
requirement of Information Technology
Equipment)

EN61000-3-2:2006 (Limits for Harmonic
Current Emission)
EN61000-3-3:1995+A1:2001+A2:2005
(Limitation of Voltage Fluctuation and Flicker)
following provisions of directives applicable
2006/95/EC (Low Voltage Directive)
2004/108/EC (EMC Directive)

2005/32/EC (EuP Directive, EC No. 1275/2008
mplementing Directive for Standby and Off
mode power consumption) and is produced
by a manufacturing organization on 1SO9000
level.

The product also comply with the following
standards

1SO9241-307:2008 (Ergonomic requirement,
Analysis and compliance test methods for
electronic visual displays)

GS EK1-2000:2009 (GS mark requirement)
prEN50279:1998 (Low Frequency Electric and
Magnetic fields forVisual Display)

MPR-II (MPR:1990:8/1990:10 Low Frequency
Electric and Magnetic fields)

TCO Displays 5.1 (Requirement for
Environment Labeling of Ergonomics,

Energy, Ecology and Emission, TCO: Swedish
Confederation of Professional Employees) for
TCO versions

Energy Star Declaration

(www.energystar.gov)

As an ENERGY STAR® Partner, we
have determined that this product
meets the ENERGY STAR® guidelines
for energy efficiency.

& Note

We recommend you switch off the monitor when
it is not in use for a long time.
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Federal Communications Commission (FCC)
Notice (U.S. Only)

€& This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide
reasonable protection against harmful
interference in a residential installation. This
equipment generates, uses and can radiate
radio frequency energy and, if not installed
and used in accordance with the instructions,
may cause harmful interference to radio
communications. However, there is no
guarantee that interference will not occur
in a particular installation. If this equipment
does cause harmful interference to radio or
television reception, which can be determined
by turning the equipment off and on, the
user is encouraged to try to correct the
interference by one or more of the following
measures:

» Reorient or relocate the receiving antenna.

* Increase the separation between the
equipment and receiver.

* Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

*  Consult the dealer or an experienced radio/
TV technician for help.

@ Changes or modifications not expressly
approved by the party responsible for
compliance could void the user's authority to
operate the equipment.

Use only RF shielded cable that was supplied with
the monitor when connecting this monitor to a
computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to rain
or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked
with FCC Logo,

United States Only

e

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following two
conditions: (1) this device may not cause harmful
interference, and (2) this device must accept any
interference received, including interference that
may cause undesired operation.
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Commission Federale de la Communication
(FCC Declaration)

© Cet équipement a été testé et déclaré

conforme auxlimites des appareils numériques
de class B,aux termes de l'article 15 Des
regles de la FCC. Ces limites sont concues

de fagon a fourir une protection raisonnable
contre les interférences nuisibles dans le cadre
d'une installation résidentielle.

CET appareil produit, utilise et peut émettre
des hyperfréquences qui, si I'appareil n'est pas
installé et utilisé selon les consignes données,
peuvent causer des interférences nuisibles aux
communications radio.

Cependant, rien ne peut garantir I'absence
d'interférences dans le cadre d'une installation
particuliere. Si cet appareil est la cause
d'interférences nuisibles pour la réception des
signaux de radio ou de télévision, ce qui peut

étre décelé en fermant I'équipement, puis en
le remettant en fonction, |'utilisateur pourrait

essayer de corriger la situation en prenant les

mesures suivantes:

* Réorienter ou déplacer I'antenne de réception.

*  Augmenter la distance entre I'équipement et
le récepteur.

* Brancher I'équipement sur un autre circuit que

celui utilisé par le récepteur.
¢ Demander l'aide du marchand ou d'un
technicien chevronné en radio/télévision.

@ Toutes modifications n'ayant pas recu
I'approbation des services compétents
en matiére de conformité est susceptible
d'interdire a I'utilisateur I'usage du présent
équipement.

N'utiliser que des cables RF armés pour

les connections avec des ordinateurs ou
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE
B RESPECTETOUTES LES EXIGENCES DU
REGLEMENT SUR LE MATERIEL BROUILLEUR
DU CANADA.

EN 55022 Compliance (Czech Republic Only)

This devica belongs to catagory B devices as describad in EN 55022, unless it is spacifi-
cally stated that it is a Class A device on the specification labal. The following appliss to
davicas in Class A of EN 55022 (radius of profection up o 30 metars). The user of the
davics is obliged to take all stape necessary to remove sources of infarfersnce o tela-
communication or other devicss.

Pulmdnan[nutypmémﬁﬂm poditade uvadeno, Ze spadé do do ffidy A podle EN 55022,

spada automaticky do tfidy B podie EN 55022, Pro zafizeni zafazend do tidy A (chranné
pésmo 30m) podie EN 55022 platl nésledujicl. Dojde-Ii k rudan( telekomunikatnich nebo
Pnych zafizeni je ufvatel povinmen provést takowvd opatfgnl, aby reSeni odstranil.




Polish Center for Testing and Certification
Notice

The equipment should draw power from a socket
with an attached protection circuit (a three-
prong socket). All equipment that works together
(computer, monitor, printer, and so on) should
have the same power supply source.

The phasing conductor of the room's electrical
installation should have a reserve short-circuit
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the
power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

A protection mark "B" confirms that the
equipment is in compliance with the protection
usage requirements of standards PN-93/1-42107
and PN-89/E-06251.

Wymagania Polskiego Centrum Badan i Certyfikacji

L,wum je powiang \ntm sitane 2 griazda 2 preybaceonym obwederm echronmye (gnisedo @
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North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR DU
STALLER DIN UTRUSTNING PAPLATS.

Placering/Ventilation

ADVARSEL:

SORGVED PLACERINGEN FOR, AT
NETLEDNINGENS STIK OG STIKKONTAKT ER
NEMT TILGANGELIGE.

Paikka/llmankierto

VAROITUS:

SIJOITA LAITE SITEN, ETTA VERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOSTI
IRROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA
DU PASSE PA AT KONTAKTENE FOR
ST@MTILFORSEL ER LETTE A NA.

BSMI Notice (Taiwan Only)

HAZHARESIE |




Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht den
in der "Verordnung Uber den Schutz vor Schaden
durch Rontgenstrahlen" festgelegten Vorschriften.

Auf der Rickwand des Gerdtes befindet sich

ein Aufkleber, der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften tber
die Bauart von Storstrahlern nach Anlage Ill @ 5
Abs. 4 der Réntgenverordnung erflllt sind.

Damit Ihr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, daf3

1. Reparaturen nur durch Fachpersonal
durchgefihrt werden.

2. nur original-Ersatzteile verwendet werden.

3. bei Ersatz der Bildrohre nur eine bauartgleiche
eingebaut wird.

Aus ergonomischen Griinden wird empfohlen,
die Grundfarben Blau und Rot nicht auf dunklem
Untergrund zu verwenden (schlechte Lesbarkeit
und erhohte Augenbelastung bei zu geringem
Zeichenkontrast wdren die Folge).

Der arbeitsplatzbezogene Schalldruckpegel nach
DIN 45 635 betrdgt 70dB (A) oder weniger.

) |ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAB NETZSTECKER UND
NETZKABELANSCHLUB LEICHT
ZUGANGLICH SIND.
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China RoHS

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products are produced and sold for
China market have to meet China RoHS request.
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7. Kundeservice og garanti

7.1 Philips' regler ved pixeldefekter pa
fladskaerme

Philips tilstreeber at levere produkter af den hgjeste
kvalitet.Vi anvender nogle af branchens mest
avancerede produktionsprocesser og udferer en
streng kvalitetskontrol. En gang imellem er defekte
pixler eller sub-pixler pa TFT skaeermpaneler dog
uundgaelige. Ingen producent kan garantere,

at alle paneler vil vaere fri for pixeldefekter,

men Philips garanterer, at enhver skaerm med

et uacceptabelt antal defekter repareres eller
udskiftes under garantien. Dette notat forklarer de
forskellige former for pixeldefekter og definerer
de acceptable defektniveauer for hver type. For

at veere berettiget til reparation eller udskiftning
under garantien skal antallet af pixeldefekter pa

et TFT skaermpanel overskride disse acceptable
niveauer: For eksempel ma hgjst 0,0004% af
sub-pixlerne pa en 19" XGA-skaerm veere
defekte. Desuden sztter Philips endnu hgjere
kvalitetsnormer for visse typer eller kombinationer
af pixeldefekter, derer mere generende end andre.
Denne pixelpolitik gzelder i hele verden.

subpixel subpixel subpixel

v
il 5

Pixler og sub-pixler

En pixel eller et billedelement er sammensat af tre
sub-pixler med primerfarverne red, gren og bla.
Ndr mange pixler settes sammen, kan de danne et
billede. Nar alle sub-pixler i en pixel lyser, fremstar
de farvede sub-pixler tilsammen som enkelt hvid
pixel. Hvis de alle er merke, fremstar de tre farvede
sub-pixler tilsammen som en enkelt sort pixel.
Andre kombinationer af oplyste og merke sub-
pixler fremstar som enkelte pixler i andre farver

Forskellige typer pixeldefekter

Pixel- og sub-pixeldefekter optreeder pa skeermen
pa forskellige mader. Der er to kategorier af
pixeldefekter og flere typer sub-pixeldefekter i
hver kategori.

Defekte lyse prikker

Defekte lyse prikker fremkommer som pixels eller
underpixels, der altid lyser eller er "pa". Det vil
sige, at en lys prik er en underpixel, der fremstar
pa skeermbilledet, ndr skeermen viser et markt
megnster. Der er felgende typer defekte lyse
prikker:

En teend red, gren eller bld sub-pixel

I @

To sammenliggende tendte sub-pixler:
Rad + Bla = Lilla

Red + Gregn = Gul

Grgn + Bla = Cyan (Lysebla)

Tre sammenliggende teendte pixler (en hvid pixel)
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€& Bemarkning

En red eller bld lys prik skal veere mere end 50
procent lysere end de omkringliggende prikker,
mens en gron lys prik er 30 procent lysere end de
omkringliggende prikker.

Defekte mgrke prikker

Defekte marke prikker fremkommer som pixels
eller underpixels, der altid er mgrke eller "fra". Det
vil sige, at en lys prik er en underpixel, der fremstar
pa skeermbilledet, nar skaermen viser et merkt
meanster. Der er felgende typer defekte mearke

prikker:

Textliggende pixeldefekter

Da pixel- og sub-pixeldefekter af samme type,
der ligger teet pa hinanden, kan vaere mere
igjnefaldende, specificerer Philips ogsa tolerancer
for teetliggende pixeldefekter.

Pixeldefekttolerancer

For at veere berettiget til reparation eller
udskiftning pa grund af pixeldefekter i
garantiperioden skal et TFT skeermpanel i en Philips
fladskeerm have pixel- eller sub-pixeldefekter,

der overskrider de tolerancer, der er gengivet i
folgende tabeller

BRIGHT DOT-DEFEKTER ACCEPTABELT NIVEAU

1 teendt sub-pixel 3
2 sammenliggende teendte sub-pixler 1
3 sammenliggende taendte sub-pixler (en hvid pixel) 0
Afstand mellem to bright dot-defekter® >15mm
Samlede bright dot-defekter af alle typer 3

BLACK DOT-DEFEKTER ACCEPTABELT NIVEAU

1 merk sub-pixel 5 eller feerre
2 sammenliggende mgrke sub-pixler 2 eller ferre
3 sammenliggende marke sub-pixler 0
Afstand mellem to black dot-defekter* >15mm
Samlede black dot-defekter af alle typer 5 eller ferre

SAMLEDE DOT-DEFEKTER

Samlede bright- eller black dot-defekter af alle typer

ACCEPTABELT NIVEAU
5 eller faerre

=] Bemarkning

1 eller 2 sammenliggende sub-pixel-defekter = 1 dot-defekt
Denne monitor er i overensstemmelse med 1SO09241-307 (ISO9241-307: Testmetoder for ergonomisk
krav, analyse og overensstemmelse for elektroniske skaerme til fremvisning)



7.2 Kundeservice og garanti

VLG DIT LAND/OMRADE FOR AT SE
OPLYSNINGER OM DIN GARANTIDAKNING

VESTEUROPA

Dstrig / Belgien / Danmark / Frankrig /

Tyskland / Graekenland / Finland / Irland / Italien /
Luxembourg / Holland / Norge / Portugal / Sverige /
Schweiz / Spanien / Storbritannien / Polen

CENTRAL- OG @STEUROPA
Tjekkiet/Ungaren/Rusland/Slovakiet/Slovenien/
Tyrkiet/Romanien/Bulgarien/Ukraine/Baltikum/
Hviderusland/Kroatien/Estland/Letland/Litauen/
Serbien & Montenegro

LATINAMERIKA
Argentina / Brasilien

NORDAMERIKA
Canada / USA

STILLEHAVSLANDENE
Australien / New Zealand

ASIEN

Kina/Hong Kong/Macau/Indien/Indonesien/Korea/
Malaysia/Pakistan/Filippinerne/Singapore/Taiwan/
Thailand/Vietnam

AFRIKA
Sydafrika

MELLEMO@STEN
Forenede Arabiske Emirater/Israel

Betingelser for din Philips garanti i Vesteuropa pr.
01 januar 2011

Kzere kunde,

Tak fordi du valgte at kebe denne
Philips-skeerm.

Alle Philips-skeerme er konstrueret
og fremstillet efter hgje standarder
og er af hgj kvalitet, brugervenlig
og nemme at installere. Hvis du
steder pd vanskeligheder under
installation eller anvendelse af dette
produkt, bedes du kontakte Philips
hjeelpecenter for at fa gleede af din
Philips garanti. Denne servicegaranti
giver dig ret til at fa en lgsning i
henhold til den model, som du har
kebt, hvis din skaerm er defekt eller
indeholder fejl.

Hvad er daekket?

Philips garantien for Vesteuropa geelder i Andorra,
Ostrig, Belgien, Cypern, Danmark, Frankrig,
Tyskland, Greekenland, Finland, Irland, Italien,
Liechtenstein, Luxemburg, Monaco, Holland,
Norge, Polen, Portugal, Sverige, Schweiz, Spanien
og Storbritannien, og kun pa skaerme, der er
oprindeligt konstrueret, fremstillet, godkendt og/
eller autoriseret til brug i disse lande.

Garantiperioden starter fra den dag du har kebt
din skeerm, og kan i tilfelde af fejl der daekkes af
garantien, sendes til service i en garantiperiode pa
24 maneder pa Philips C, E, TV og X modellerne,
og pa B, P og S modellerne giver vi 36 maneders
garanti. Dit originale kebsdokument er dit garanti
pa kebsdatoen, sd du bedes opbevare dette pa et
sikkert sted, og have det klar hvis produktet skal
sendes til service.
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P3 C E TV og X modellerne, hentes din skaerm
pa din adresse, hvorefter den repareres pa vores
certificeret servicecenter og sendes retur til din
adresse, alt indenfor 7 arbejdsdage. Hvis skaermen
ikke kan repareres indenfor 10 arbejdsdage efter
den er blevet athentet, sendes en ny skaerm af
mindst den samme model til dig.
Ombytningsskeermen vil veere din ejendom, og
Philips beholder den defekte/oprindelige skaerm.
For ombytningsskeermen gaelder den samme
garantiperiode som for den oprindelige skaerm,
nemlig 24 maneder fra kgbsdatoen for den
oprindelige skaerm.

Pa B, P og S modellerne, vil skaermen byttes til

en skarm af mindst tilsvarende model i tilfeelde
af defekter, der er omfattet af garantien. Det er
Philips mal at returnere skaermen indenfor 48
timer efter anmodning om servicering, men pa
fierntliggende omrader; sasom w@er eller andre
steder; som geografisk er svaert at na ud til, er det
Philips mal at returnere skaermen indenfor 72
timer:

Ombytningsskeermen vil veere din ejendom, og
Philips beholder den defekte/oprindelige skaerm.
For ombytningsskeermen gaelder den samme
garantiperiode som for den oprindelige skeerm,
nemlig 36 maneder fra kebsdatoen for den
oprindelige skaerm.

Hvad er ikke inkluderet?

Philips garanti deekker under forudsatning af,

at produktet behandles korrekt og anvendes til
det tilsigtede formal i overensstemmelse med
dens brugervejledning, og ved forevisning af den
originale faktura eller kvittering med angivelse af
kabsdatoen, forhandlerens navn samt model og
produktionsnummer for produktet.

Philips garanti galder eventuelt ikke, hvis:

*  Dokumenterne er endret eller pa nogen
made er gjort uleselige.

*  Modellen eller produktionsnummeret pa
produktet er &ndret, slettet, fiernet eller gjort
uleeseligt.

* Reparationer eller produktendringer er udfert
af uautoriserede serviceorganisationer eller
personer.

* Skade, der er opstaet som felge af uheld,
herunder men ikke begraenset til lynnedslag,
vand eller ild, misbrug eller forssmmelighed.

*  Modtageproblemer forarsaget af signalforhold,
kabel eller antennesystemer udenfor
produktet;

* Defekter, der er fordrsaget af misbrug af
monitoren:;

*  Produkter der kraever modifikation eller
tilpasning for; at de kan opfylde de lokale eller
nationale tekniske standarder, som galder i
lande, for hvilket produktet ikke oprindeligt
var designet, fremstillet, godkendt og/eller
autoriseret. Derfor skal du altid kontrollere om
et produkt kan bruges i et specifikt land.

*  Bemark, at Philips F1rst garantien ikke daekker
produkter, der ikke oprindeligt er konstrueret,
fremstillet, godkendt og/eller autoriseret til
brug i Philips-lande. | sadanne tilfelde gaelder
Philips verdensomspaendende garanti.

Kun et klik vaek

| tilfelde af problemer; anbefaler vi at du leeser
brugervejledningen grundigt, eller gar pa
http://www.philips.com/support hjemmesiden for
yderligere support.

Kun et telefonopkald vaek

For at undga unedig ulejlighed, tilrader vi at leese
brugervejledningen omhyggeligt eller fa yderligere
hjeelp ved at ga pa vores hjemmeside
http://www.philips.com/support, far du kontakter
Philips hjelpecenter.

For at fd problemet lgst hurtigst og nemmest,

bedes du have falgende oplysninger Klar, far du

kontakter Philips hjeelpecenter:

e Philips typenummer

*  Philips serienummer

*  Kabsdato (kopi af kebsbevis kan vaere
pakreevet)
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*  PC processor:
o CPU og grafikkortsnavn og driverversion
o Operativsystem
o Program bruges

* Andre installerede kort

Hvis folgende oplysninger er til radighed, vil det ogsa befordre sagen:

*  Kegbsbevis med angivelse af: Kgbsdato, forhandlernavn, model og produktserienummer:
* Den fuldsteendige adresse, hvor den fejlbehaftede skeerm skal afhentes, og ombytningsmodellen skal

leveres til.
Philips’ kundeservice findes over hele verden.

Eller du kan finde os via hjemmesiden:
Hjemmeside: http//www.philips.com/support

Kontaktoplysninger i Vesteuropa:

Tyskland +49 01803 386 853 €009
Storbritannien +44 0207 949 0069 L okal opkaldstakst
Irland +353 01 601 1161 Lokal opkaldstakst
Spanien +34 902 888 785 €0,10
Finland +358 09 2290 1908 Lokal opkaldstakst
Frankrig +33 082161 1658 €0,09
Greaekenland +30 00800 3122 1223 Gratis
[talien +39 840 320 041 €008
Holland +31 0900 0400 063 €0,10
Denmark +45 3525 8761 Lokal opkaldstakst
Norge +47 2270 8250 Lokal opkaldstakst
Sverige +46 08 632 0016 Lokal opkaldstakst
Polen +48 0223491505 Lokal opkaldstakst
Dstrig +43